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Preface

The Cisco CallManager Extended Services Administrator’s Guide provides 
instructions for installing, configuring and administering 
Cisco CallManager Extended Services. This document will help you to:

• Understand Cisco CallManager Extended Services and how its applications 
work. 

• Perform product installation. 

• Perform initial configuration. 

• Perform ongoing administration tasks.

• Troubleshoot problems with the applications. 

Audience
The Cisco CallManager Extended Services Administrator’s Guide is written for 
a server administrator or network administrator who is responsible for 
implementing Cisco CallManager Extended Services. No programming skills are 
required.
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Organization
Organization
This guide is organized as follows:

Chapter Title Description

Chapter 1 Understanding 
Cisco CallManager 
Extended Services

A general overview of 
Cisco CallManager Extended  
Services and the IP Telephony 
software suite.

Chapter 2 Installing 
Cisco CallManager 
Extended Services

Sequenced procedures for the initial 
installation of Cisco CallManager
Extended Services.

Chapter 3 Configuring 
Cisco CallManager 
Extension Mobility

Sequenced procedures for the initial 
configuration of Cisco CallManager
Extension Mobility.

Chapter 4 Configuring 
Cisco CallManager 
AutoAttendant

Sequenced procedures for the initial 
configuration of 
Cisco CallManager AutoAttendant.

Chapter 5 Administering 
Cisco CallManager 
Extended Services

Procedures for managing 
Cisco CallManager
Extended Services on an ongoing 
basis.

Chapter 6 Troubleshooting 
Cisco CallManager 
Extended Services

Procedures for troubleshooting 
Cisco CallManager
Extended Services and clearing error 
messages. 
x
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Related Documentation
Related Documentation
For information about Cisco CallManager, refer to the following documents:

• Cisco CallManager System Guide

• Cisco CallManager Administration Guide

For information about Cisco Customer Response Applications, refer to the 
following documents:

• Getting Started with Cisco Customer Response Applications

• Cisco Customer Response Applications Administrator’s Guide

• Cisco Customer Response Applications Developer’s Guide

• Cisco Customer Response Applications Troubleshooting Guide

Conventions
This document uses the following conventions:

Convention Description

boldface font Commands and keywords are in boldface.

italic font Arguments for which you supply values are in italics.

[ ] Elements in square brackets are optional.

{ x | y | z } Alternative keywords are grouped in braces and 
separated by vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in brackets 
and separated by vertical bars.

string A nonquoted set of characters. Do not use quotation 
marks around the string or the string will include the 
quotation marks.

screen font Terminal sessions and information the system displays 
are in screen font.

boldface screen 
font

Information you must enter is in boldface screen 
font.
xi
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Conventions
Notes use the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication.

Timesavers use the following conventions:

Timesaver Means the described action saves time. You can save time by performing the 
action described in the paragraph.

Tips use the following conventions:

Tips Means the following are useful tips.

Cautions use the following conventions:

Caution  Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

italic screen font Arguments for which you supply values are in italic 
screen font.

^ The symbol ^ represents the key labeled Control—for 
example, the key combination ^D in a screen display 
means hold down the Control key while you press the 
D key.

< > Nonprinting characters, such as passwords are in angle 
brackets.

Convention Description
xii
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Obtaining Documentation
Warnings use the following conventions:

Warning This warning symbol means danger. You are in a situation that could cause 
bodily injury. Before you work on any equipment, you must be aware of the 
hazards involved with electrical circuitry and familiar with standard 
practices for preventing accidents. 

Obtaining Documentation
The following sections provide sources for obtaining documentation from 
Cisco Systems.

World Wide Web
You can access the most current Cisco Systems documentation on the World Wide 
Web at the following sites:

• http://www.cisco.com

• http://www-china.cisco.com

• http://www-europe.cisco.com

Documentation CD-ROM
Cisco documentation and additional literature are available in a CD-ROM 
package, which ships with your product. The Documentation CD-ROM is updated 
monthly and may be more current than printed documentation. The CD-ROM 
package is available as a single unit or as an annual subscription.
xiii
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Obtaining Documentation
Ordering Documentation
Cisco Systems documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco Product documentation 
from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM through 
the online Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered CCO users can order documentation through a local account 
representative by calling Cisco corporate headquarters (California, USA) at 
408 526-7208 or, in North America, by calling 800 553-NETS(6387).

Documentation Feedback
If you are reading Cisco product documentation on the World Wide Web, you can 
submit technical comments electronically. Click Feedback in the toolbar and 
select Documentation. After you complete the form, click Submit to send it to 
Cisco.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, for your convenience many documents contain 
a response card behind the front cover. Otherwise, you can mail your comments 
to the following address:

Cisco Systems, Inc.
Document Resource Connection
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
xiv
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Obtaining Technical Assistance
Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance. 
Customers and partners can obtain documentation, troubleshooting tips, and 
sample configurations from online tools. For Cisco.com registered users, 
additional troubleshooting tools are available from the TAC website. 

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services that 
provides immediate, open access to Cisco information and resources at anytime, 
from anywhere in the world. This highly integrated Internet application is a 
powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers and 
partners streamline business processes and improve productivity. Through 
Cisco.com, you can find information about Cisco and our networking solutions, 
services, and programs. In addition, you can resolve technical issues with online 
technical support, download and test software packages, and order Cisco learning 
materials and merchandise. Valuable online skill assessment, training, and 
certification programs are also available.

Customers and partners can self-register on Cisco.com to obtain additional 
personalized information and services. Registered users can order products, check 
on the status of an order, access technical support, and view benefits specific to 
their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center
The Cisco Technical Assistance Center (TAC) website is available to all 
customers who need technical assistance with a Cisco product or technology that 
is under warranty or covered by a maintenance contract.
xv
Cisco CallManager Extended Services Administrator’s Guide

78-12959-01



Obtaining Technical Assistance
Contacting TAC by Using the Cisco TAC Website

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC 
by going to the TAC website:

http://www.cisco.com/tac

P3 and P4 level problems are defined as follows:

• P3—Your network performance is degraded. Network functionality is 
noticeably impaired, but most business operations continue.

• P4—You need information or assistance on Cisco product capabilities, 
product installation, or basic product configuration.

In each of the above cases, use the Cisco TAC website to quickly find answers to 
your questions. 

To register for Cisco.com, go to the following website:

http://www.cisco.com/register/

If you cannot resolve your technical issue by using the TAC online resources, 
Cisco.com registered users can open a case online by using the TAC Case Open 
tool at the following website:

http://www.cisco.com/tac/caseopen

Contacting TAC by Telephone 

If you have a priority level 1(P1) or priority level 2 (P2) problem, contact TAC 
by telephone and immediately open a case. To obtain a directory of toll-free 
numbers for your country, go to the following website:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

P1 and P2 level problems are defined as follows:

• P1—Your production network is down, causing a critical impact to business 
operations if service is not restored quickly. No workaround is available.

• P2—Your production network is severely degraded, affecting significant 
aspects of your business operations. No workaround is available.
xvi
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C H A P T E R 1

Understanding Cisco CallManager 
Extended Services

Cisco CallManager Extended Services bring valuable IP telephony capabilities to 
a Cisco CallManager deployment. These new extended services significantly 
differentiate Cisco’s IP Telephony solution from features provided with 
traditional PBX systems.

Cisco CallManager Extended Services consist of two features: 
Cisco CallManager Extension Mobility and Cisco CallManager AutoAttendant. 

Use this document if you are running Cisco CallManager Extended Services with 
Cisco CallManager pre-3.3(2) and Cisco Customer Response Application 
(Cisco CRA) 2.2 and later.

Note With Cisco CallManager 3.3(2) and later, the Cisco CallManager 
Extension Mobility application and the Cisco CallManager 
Extension Mobility service in Cisco CallManager provide the 
extension mobility functionality. The feature no longer requires the 
Cisco CRA engine. If you are using Extension Mobility and AutoAttendant 
with Cisco CallManager 3.3(2) and later, see the Cisco CallManager Features 
and Services Guide at the following URL: 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/index.htm
1-1
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Chapter 1 Understanding Cisco CallManager Extended Services
Cisco CallManager Extension Mobility Overview
This section provides an introduction to Cisco CallManager Extended Services:

• Cisco CallManager Extension Mobility Overview, page 1-2

• Cisco CallManager AutoAttendant Overview, page 1-4

• Components of Cisco CallManager Extended Services, page 1-6

Cisco CallManager Extension Mobility Overview
The Cisco CallManager Extension Mobility feature allows users within a 
Cisco CallManager cluster to configure any Cisco IP Phone7960/7940 as their 
own, temporarily, by logging in to that phone. Once logged in, the phone adopts 
the user’s personal phone number(s), speed dials, services links and other 
user-specific properties. After logout, the phone adopts the original user profile.

With Cisco CallManager Extension Mobility, several employees can share office 
space on a rotational basis instead of having a designated office.This approach is 
commonly used in work environments such as sales offices and consulting firms 
where employees do not routinely conduct business in the same place or keep the 
same hours every day. 

Login Service
Administrators can program the login service, an XML-based authentication 
service, for a variety of uses, including duration limits on phone configuration and 
login authorization for particular phones. Programming is done in 
Cisco CallManager Service Parameters Configuration.

The user interface to the login service is accessed through the Services button on 
Cisco IP Phone Models 7960 or 7940. The user enters login information in the 
form of a UserID and a Personal Identification Number (PIN). The 
Login Application receives the XML-over-HTTP request and verifies the 
information against the Cisco IP Telephony Directory (see Figure 1-1). The 
phone is reconfigured automatically with the individual user device profile 
information.
1-2
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Chapter 1 Understanding Cisco CallManager Extended Services
Cisco CallManager Extension Mobility Overview
Logout Service
The user logs out by pressing the Services button and selecting logout. After the 
user logs out, Cisco CallManager sends the original user profile to the phone and 
restarts the phone. 

Figure 1-1 Cisco CallManager Extension Mobility Architecture
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Chapter 1 Understanding Cisco CallManager Extended Services
Cisco CallManager AutoAttendant Overview
Cisco CallManager AutoAttendant Overview
The Cisco CallManager AutoAttendant (Cisco CallManager AA), illustrated in 
Figure 1-2, works with Cisco CallManager to receive calls on specific telephone 
extensions and to allow callers to select appropriate extensions. 

Figure 1-2 Using Cisco CallManager AA 
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Chapter 1 Understanding Cisco CallManager Extended Services
Cisco CallManager AutoAttendant Overview
The Cisco CallManager AA provides the following functionality:

• Answers a call

• Plays a user-configurable Welcome prompt

• Plays a Main Menu prompt, asking the user to perform one of three actions:

– Press “0” for the operator

– Press “1” to enter an extension number

– Press “2” to spell by name

• If the caller chooses to spell by name (option 2), the system compares the 
letters entered with the names configured to the available extensions. 

– If one matches, the system prompts the user for confirmation of the name, 
and transfers the call to that user’s primary extension.

– If there is more than one match, the system prompts the user to select the 
correct extension. 

– If there are too many matches, the system prompts the user to enter more 
characters.

• When the caller has specified the destination, the system transfers the call.

– If the line is busy or not in service the system informs the user 
accordingly and replays the Main Menu prompt.
1-5
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Chapter 1 Understanding Cisco CallManager Extended Services
Components of Cisco CallManager Extended Services
Components of Cisco CallManager 

Extended Services
The Cisco Customer Response (CR) Platform provides the components required 
to run Cisco CallManager Extended Services. The Cisco CR platform provides a 
multimedia (voice/data/Web) IP-enabled customer care application environment. 
The Cisco CR Platform uses Voice over IP (VoIP) technology, so your telephony 
network can share resources with your data network.

Cisco CallManager Extended Services uses four main components of the 
Cisco Customer Response Platform:

• Gateway—Connects the enterprise IP telephony network to the Public 
Switched Telephone Network (PSTN) and to other private telephone systems 
such as Public Branch Exchange (PBX).

• Cisco CallManager Server—Provides the features required to implement IP 
phones, manage gateways, provides failover and redundancy service for the 
telephony system, and directs Voice over IP (VoIP) traffic to the 
Cisco Customer Response Application (Cisco CRA) system.

• Cisco IP Telephony Directory—Stores configuration information and 
Cisco CRA application scripts in a LDAP directory. The subdirectory that 
stores Cisco CRA scripts is called the repository. Storing application scripts 
and configuration information in an LDAP directory allows you to load 
application scripts on any Cisco CRA engine in the network. The repository 
keeps one backup version of each script for recovery purposes. You can 
revert to the previous version if necessary.

• Cisco CRA Server—Contains the Cisco CRA Engine that runs Cisco CRA 
applications. Cisco CRA applications comprise a series of steps, 
implemented as Java Beans packaged in .jar files.
1-6
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Chapter 1 Understanding Cisco CallManager Extended Services
Components of Cisco CallManager Extended Services
Figure 1-3 shows how Cisco CRA integrates with your Cisco IP telephony 
solution. 

Figure 1-3 shows Cisco CallManager and Cisco CRA systems running on 
separate servers. You can install Cisco CallManager Extended Services 
co-resident on the same server as Cisco CallManager or on a separate server.

Figure 1-3 Cisco IP Telephony Solution Components

For more information about the Cisco CR Platform, refer to the Cisco Customer 
Response Applications Administrator’s Guide.
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Chapter 1 Understanding Cisco CallManager Extended Services
Components of Cisco CallManager Extended Services
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C H A P T E R 2

Installing Cisco CallManager 

Extended Services

This section describes how to install Cisco CallManager Extended Services on a 
Cisco Media Convergence Server (Cisco MCS) or on a Cisco certified server: 

1. Before You Install, page 2-1

2. Installing Cisco CallManager Extended Services, page 2-3

Before You Install
Before you begin the installation of Cisco CallManager Extended Services, 
ensure that you have met hardware and software requirements and configured 
Windows 2000 components. Check the “Hardware Requirements” section on 
page 2-2 and the “Software Requirements” section on page 2-2 before you 
proceed. 
2-1
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Chapter 2 Installing Cisco CallManager Extended Services
Before You Install
Hardware Requirements
Cisco CallManager Extended Services run on the Cisco Media Convergence 
Server (Cisco MCS) platform or a customer-provided Cisco-certified server such 
as the Compaq DL320 and DL380 and the IBM-330 and IBM-340.

Cisco recommends that you can install Cisco CallManager Extended Services 
co-resident on the same server as Cisco CallManager. 

Hardware requirements for a co-resident server configuration of 
Cisco CallManager Extended Services are:

• The installation of Cisco CallManager Extended Services requires 275MB.

• Running Cisco CallManager Extended Services requires 512MB for the 
Cisco MCS 7820 series (7820, 7822, and 7825) and 1GB for the Cisco MCS 
7930 series (7930 and 7935).

Software Requirements
Cisco CallManager Extended Services requires the following software 
components to operate:

• Cisco CallManager 3.1

• Microsoft Windows 2000
2-2
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Chapter 2 Installing Cisco CallManager Extended Services
Installing Cisco CallManager Extended Services
Installing Cisco CallManager Extended Services
Install Cisco CallManager 3.1 and Windows 2000 before you install 
Cisco CallManager Extended Services. 

Note If you do not have Cisco CallManager 3.1 installed first, 
Cisco CallManager Extended Services will abort during its installation.

Note You must configure proxy settings for Internet Explorer and verify that you 
can browse to the internal and external web site. For details on configuring 
your proxy settings, contact your network administrator.

Downloading and Installing 
Cisco CallManager Extended Services from the Internet

To install Cisco CallManager Extended Services, perform the following steps:

Procedure

Step 1 Start up the Cisco MCS or Cisco certified server and log into Windows 2000.

Step 2 Use a web browser to access the following URL:

http://www.cisco.com/cgi-bin/tablebuild.pl/callmgr-31

Click the CallManager Upgrades link.

Step 3 Locate Cisco CallManager Extended Services and download the file: 
cm-es.ffr.2-2-1.exe.

Step 4 Double-click on the downloaded file to launch the installer.

Step 5 Click Next at the Welcome to the Cisco CallManager Extended Services 
Installation Wizard window.
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Chapter 2 Installing Cisco CallManager Extended Services
Installing Cisco CallManager Extended Services
Step 6 A window appears with a checklist of applications offered by 
Cisco CallManager Extended Services. See Figure 2-1.

Check the box next to the applications you wish to install:

• CallManager Cisco AA

• Cisco Extension Mobility

Step 7 Click the Next button. 

Figure 2-1 Installing Cisco CallManager Extended Services 

Step 8 If you are installing a Cisco CallManager application for the first time, skip to 
Step 11.

If you are performing a reinstall or upgrade, the system asks you to confirm that 
you want to reinstall.

Step 9 Click Yes.
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Chapter 2 Installing Cisco CallManager Extended Services
Installing Cisco CallManager Extended Services
Step 10 At this point, the installation checks for the presence of Cisco CallManager 3.1.

If Cisco CallManager Release 3.1 is not present, you are prompted to upgrade to 
Cisco CallManager Release 3.1.The installation of Cisco CallManager 
Extended Services will not continue until Cisco CallManager Release 3.1 is 
present. 

Step 11 Confirm your installation selection by clicking Yes. 

The system displays a message asking where the Cisco CallManager Database is 
located.

Step 12 To install Cisco CallManager Extension Mobility on the same server as 
Cisco CallManager, select This Server. 

To install Cisco CallManager Extension Mobility on a different server from 
Cisco CallManager, select A Different Server and enter the server’s hostname, 
and a username and password.

Step 13 Click Next.

Step 14 At the CiscoWorks2000 Syslog Configuration screen you can elect to configure 
the CiscoWorks2000 Syslog collector.

If you have a CiscoWorks2000 server on your network, you can click the 
Configure CiscoWorks2000 Syslog Collector check box to install the 
CiscoWorks Syslog Collector module on this computer. If you click this check 
box, enter the location of your CiscoWorks2000 server.

If you do not have a CiscoWorks 2000 server on your network, do not click the 
Configure CiscoWorks 2000 Syslog Collector check box.

Step 15 At the Ready to Install Cisco CallManager Extended Services window, click 
Next.

The system takes approximately 10 minutes to install Cisco CallManager 
Extended Services.

Step 16 The installation blanks the administrator password. Re-enter the password as 
shown here: 

a. Enter the new password to be used for the MCS or Cisco certified server. 
Click Okay. 

b. Enter the new password to be used for the SQL Server. Click Okay. 

Step 17 To reboot, click Yes when prompted.
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Upgrading Cisco CallManager AutoAttendant or Re-installing Cisco CallManager 

Extended Services

To upgrade to Cisco CallManager Extended Services from an earlier version of 
Cisco CallManager AutoAttendant, or to re-install the current version of 
Cisco CallManager Extended Services, perform the following steps:

Procedure

Step 1 On the Cisco CallManager server, choose 
Start  > Programs > Cisco CRA Administrator> Application Administrator. 

Enter your user name and password and click OK.

The Application Administration Setup page appears.

Step 2 Click Setup on the Application Administration Setup page.

The Directory Configuration page appears. The necessary fields are 
pre-populated with your directory configuration data.

Step 3 Click OK to confirm the directory configuration.

Step 4 Launch a command window by choosing Start > Run.

Step 5 Enter “cmd” and click OK.

Step 6 Set the directory to
C:\Program Files\wfavvid.

Step 7 If you are upgrading from Cisco CallManager AutoAttendant Release 2.0, 
run: “UpgradeAA.bat.”

Note You do not need to reboot after this procedure.
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C H A P T E R 3

Configuring CiscoCallManager 

ExtensionMobility

The following topics describe how to configure Cisco CallManager 
Extension Mobility:

• Rules for Configuring Cisco CallManager Extension Mobility, page 3-1.

• Procedures for Configuring Cisco CallManager Extension Mobility, 
page 3-6

This chapter also includes information for you to give Cisco CallManager 
Extension Mobility users. See the “Preparing the User for Cisco CallManager 
Extension Mobility” section on page 3-35.

Rules for Configuring Cisco CallManager 

Extension Mobility
It is important to understand how device profiles work with Cisco CallManager 
Extension Mobility in order to configure the service correctly.

This section discusses the following topics:

• Managing Device Profiles, page 3-2

• Logging In and Logging Out, page 3-3

• Configuration Examples, page 3-3

• Configuration Rules, page 3-5
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Managing Device Profiles
A device profile is made up of a set of attributes (services and/or features) 
associated with a particular device. Device profiles include name, description, 
phone template, add-on modules, directory numbers, subscribed services, and 
speed dial information. 

You can think of the device profile as a device which is not yet physically 
embodied. It has all the properties of a device except those which are explicitly 
tied to a device, like MAC address or directory URL, for example.

When a device profile has been loaded onto a device, that device adopts the 
attributes of that device profile. A device can adopt a device profile when there is 
no user logged in (that is, when a device is first initialized and when a user logs 
out) or when a user logs in. 

There are two types of device profiles: autogenerated device profiles and user 
device profiles. 

Autogenerated Device Profile

An autogenerated device profile generates when you update the phone settings 
and choose a current setting to generate an autogenerated device profile. An 
autogenerated device profile represents a snapshot of an existing device’s 
configuration. 

The autogenerated device profile associates with a specific phone to be the logout 
device profile. That is, when a logout command for a device is received, this is the 
profile loaded onto a device. 

An autogenerated device profile cannot be associated with a user. An 
autogenerated device profile can only be loaded onto a device when there is no 
user logged in. You can modify the autogenerated device profile, but not delete it.

User Device Profile

You can assign a user device profile to a user so that when a user logs in or out of 
a device, the corresponding user device profile is loaded onto that device. Devices 
can adopt user device profiles when a user logs into a device or when there is no 
user logged in.You can modify, or delete a user device profile in the Cisco 
CallManager administration pages.
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Logging In and Logging Out
When a user logs in, the current configuration of a device is replaced by a 
particular user device profile.

When a user logs out, the current configuration of a device (the user default device 
profile) is replaced by the logout profile. 

Cisco CallManager Extension Mobility supports only one login at a time on a 
device. Subsequent logins will fail. 

You cannot log out of a device which does not have anyone logged in.

Configuration Examples
This section describes different scenarios using Cisco CallManager 
Extension Mobility:

• Scenario 1: All Users have Cisco CallManager Extension Mobility, page 3-3

• Scenario 2: Mixed Configuration, page 3-4

• Scenario 3: Mixed Configuration, page 3-4

Scenario 1: All Users have Cisco CallManager Extension Mobility

In a typical Cisco CallManager Extension Mobility scenario, all employees are 
users of Cisco CallManager Extension Mobility. The users are configured to have 
a default device profile and they do not control their individual phones. They must 
log into a phone before they can use it as their extension.

Employees have access to common devices, such as lobby phones, conference 
room phones, and cubicle phones that are meant to be shared.

When users go to the Cisco Phone User Options web pages to change their 
services or speed dials, they can select only their default device profiles from the 
“Select a device to configure” drop-down menu. Any changes users make to their 
services follows them to any phone they log into. 

Note In this scenario, users cannot modify settings for an individual phone.

This is a recommended configuration.
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Scenario 2: Mixed Configuration

In this configuration, each user has a phone assigned to him. Each user has a 
device profile too which follows him on every device he logs into. Each user has 
access to common devices, such as lobby phones, conference room phones, and 
cubicle phones that are meant to be shared.

Note In this scenario, no one is allowed to use anyone else’s phone.

This is a recommended configuration.

Scenario 3: Mixed Configuration

In this scenario, some employees may have a regular desk phone and other users 
can log into this phone.

This is not a recommended configuration for Cisco CallManager 
Extension Mobility for the following reasons.

When a device is configured for Cisco CallManager Extension Mobility, a 
snapshot of that device is taken which is used as a profile after a user logs off that 
device. 

With Cisco CallManager Extension Mobility enabled on Tom’s personal 
extension, Tom goes to his Cisco Phone User Options web pages to configure 
services. He has two options from the “Select device to configure” drop-down 
menu: the device (the office phone) he controls or the Default Device Profile.

• If Tom selects his office phone and it is a device which a user controls, Tom 
can add services such as speed dials or Cisco stock price display. If Dick logs 
into that phone, Dick’s default device profile is loaded onto that phone. When 
Dick logs off, the snapshot profile, without the speed dials and Cisco stock 
price display, is loaded on the phone.

• If Tom selects his Default Device Profile from the “Select device to 
configure” down-down menu, the changes that he makes to this profile will 
appear only on the phone on which he logs into immediately after making the 
change and not on the device he controls.
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Configuration Rules
To avoid problems deploying Cisco CallManager Extension Mobility, be sure to 
follow these configuration rules:

• If you want to enable all phones within your Cisco CallManager cluster for 
Cisco CallManger Extension Mobility, you must not allow the users to 
control these devices. That is, when a user goes to the Cisco IP Phone User 
Options web page to change his services, he can only select “Default Device 
Profile” from the “Select a device to configure” drop-down list. He cannot 
modify the settings for an individual phone.

• If there is a device which a particular user controls, for example, his office 
phone, you must not allow anyone else to log into that device. 

Note The administrator can change the services for a phone in the 
Cisco CallManager Administration page. After making the changes, if he 
updates on the main page (not the pop up menu) the administrator is prompted 
to reset the phone for the changes to take affect. Then, the new snapshot is 
stored as the logout profile.

Note It is recommended that each user of Cisco CallManager Extension Mobility 
log into his phone at the beginning of the work day. This ensures that his 
default device profile is loaded on his phone. He can make changes to this 
profile and it will follow him where he logs in.
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Procedures for Configuring Cisco CallManager 
Extension Mobility

Perform the following procedures to configure Cisco CallManager 
Extension Mobility.

Caution For successful configuration of Cisco CallManager Extension Mobility, 
perform all the procedures in the order shown and follow all steps thoroughly.

1. Creating a New Application User, page 3-7

2. Configuring the Cisco CRA Engine, page 3-10

a. Adding the Login Application, page 3-10

b. Adding the Logout Application, page 3-13

c. Adding the Login Application Trigger, page 3-15

d. Adding the Logout Application Trigger, page 3-17

3. Configuring Cisco CallManager for Cisco CallManager Extension Mobility, 
page 3-19

a. Adding the Login Service, page 3-19

b. Adding the Logout Service, page 3-21

c. Setting the Service Parameters, page 3-23

d. Creating the Default Device Profile for a User, page 3-26

e. Associating a User Device Profile to a User for Cisco CallManager 
Extension Mobility, page 3-28

f. Configuring the Cisco IP Phones for 
Cisco CallManager Extension Mobility, page 3-30

4. Setting up Anonymous Access on IBM-340 platforms, page 3-34

This section also includes information to give Cisco CallManager 
Extension Mobility users. See the “Preparing the User for Cisco CallManager 
Extension Mobility” section on page 3-35.
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Creating a New Application User 
To create a new application user for Cisco CallManager Extension Mobility, 
perform the following steps:

Procedure

Step 1 On the Cisco CallManager server, choose 
Start > Programs > Cisco CallManager 3.1 > CallManager Administration.

You can also connect to the Cisco CallManager server by using the following 
URL:

http://servername/ccmAdmin

where servername is the DNS name or IP address of your Cisco CallManager 
server.

You will be prompted to enter the network password.

Step 2 Choose User > Add a New User.

Step 3 At the Add a New User screen, enter the first name (for example, extension), last 
name (for example, mobility), and UserID (for example, emapplication).

Step 4 At the User Password and Confirm Password fields, enter a password of your 
choice.

Step 5 At the PIN field, enter a numeric Personal Identification Number (PIN) of your 
choice. Confirm the PIN number.

Step 6 To save your changes and add the user, click Insert.
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Step 7 In the User Information page, select Extension Mobility from the left pane (see 
Figure 3-1).

Figure 3-1 Adding Cisco CallManager Extension Mobility for the User

A new User Information page displays.
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Step 8 Scroll down the User Information page. At the Enable Authentication Proxy 
Rights check box, click Enabled (see Figure 3-2).

Step 9 Click Update.

Figure 3-2 Enabling Authentication Proxy Rights

Related Topics:

• Configuring Cisco CallManager Extension Mobility, page 3-1

• Configuring the Cisco CRA Engine, page 3-10
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Configuring the Cisco CRA Engine 
To configure the Cisco Customer Response Application (CRA) Engine for 
Cisco CallManager Extension Mobility, perform the following procedures:

1. Adding the Login Application, page 3-10

2. Adding the Logout Application, page 3-13

3. Adding the Login Application Trigger, page 3-15

4. Adding the Logout Application Trigger, page 3-17

Adding the Login Application

To add the Login Application for Cisco CallManager Extension Mobility, 
perform the following steps:

Procedure

Step 1 Connect to the application server by using the following URL:

http://servername/AppAdmin

where servername is the DNS name or IP address of your 
Cisco Customer Response Application Engine (Cisco CRA Engine).

Step 2 Click Generic Applications. 

The Application page displays.

Step 3 On the Application page, click Add new application.

Step 4 In the Application Name field, enter any name for the application (for example, 
Login).

Step 5 At the Cisco Script Application Configuration page, use the drop-down arrow and 
select the hotel.aef script. The system populates the script name with hotel.aef, as 
shown in Figure 3-3.
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Figure 3-3 Selecting the Login Application

Step 6 Click Next.

Step 7 In the Application ID field, enter a unique Application Identifier between 1 and 
50.

Step 8 In the Maximum Number of Sessions field, enter the number of concurrent HTTP 
sessions between 1 and 50.

Step 9 At the Enabled field, enter Yes.

Step 10 Enter the following parameters: the user name and password of the user you 
created in the “Creating a New Application User” section on page 3-7.

See Figure 3-4.

Step 11 Click Update.
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Figure 3-4 Adding the Login Application

Related Topics:

• Creating a New Application User, page 3-7

• Adding the Logout Application, page 3-13
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Adding the Logout Application

To add the Logout Application for Cisco CallManger Extension Mobility, 
perform the following steps:

Procedure

Step 1 On the Application Administration page, click Generic Applications. This takes 
you to the Application page.

Step 2 On the Application page, click the Add new application link.

Step 3 In the Application Name field, enter any name for the application (for example, 
Logout).

Step 4 At the Cisco Script Application Configuration page, use the drop-down arrow and 
select the hotelOut.aef script. The system populates the script name with 
hotelOut.aef (see Figure 3-5). 

Figure 3-5 Selecting the Logout Application

Step 5 Click Next.
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Step 6 In the Application ID field, enter a unique Application Identifier between 
1 and 50.

Step 7 In the Maximum Number of Sessions field, enter the number of concurrent HTTP 
sessions between 1 and 50.

Step 8 At the Enabled field, enter Yes.

Step 9 Enter the following parameters: the user name and password of the user you 
created in Creating a New Application User, page 3-7. (See Figure 3-6.)

Step 10 Click Update.

Figure 3-6 Adding the Logout Application
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Related Topics:

• Adding the Login Application, page 3-10

• Adding the Login Application Trigger, page 3-15

Adding the Login Application Trigger 

To add the Extension Mobility Login Application Trigger, perform the following 
steps:

Procedure

Step 1 On the Application Administration page, click the HTTP Triggers link.

Step 2 Click Add new HTTP Trigger.

Step 3 At the Trigger Name field, enter a trigger (for example, /login).

Tips Be sure to start your Trigger Name with a backward slash: “/”.

Step 4 Select the application you created in the “Adding the Login Service” section on 
page 3-19 (for example, Login).

Step 5 In the Maximum Number of Sessions field, enter the number of concurrent HTTP 
sessions between 1 and 50.

Step 6 At the Enabled field, click Yes (see Figure 3-7).
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Figure 3-7 Adding the Login Application Trigger

Step 7 Click Update.

Step 8 Click Return to Main Menu.

Related Topics:

• Adding the Logout Application, page 3-13

• Adding the Logout Application Trigger, page 3-17
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Adding the Logout Application Trigger

You add the Extension Mobility Logout Application Trigger the same way you 
added the Login Application Trigger. Perform the following steps:

Procedure

Step 1 On the Application Administration page, click the HTTP Triggers link.

Step 2 Click Add new HTTP Trigger.

Step 3 At the Trigger Name field, enter a trigger (for example, /logout).

Tips Be sure to start your Trigger name with a backward slash: “/”.

Step 4 Select the application you created in the “Adding the Logout Service” section on 
page 3-21 (for example, Logout). 

See Figure 3-8 on page 3-17.

Figure 3-8 Adding the Logout Application Trigger
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Step 5 In the Maximum Number of Sessions field, enter the number of concurrent HTTP 
sessions between 1 and 50.

Step 6 At the Enabled field, enter Yes.

Step 7 Click Update.

Step 8 Click Return to Main Menu.

Related Topics:

• Adding the Login Application Trigger, page 3-15

• Configuring Cisco CallManager for Cisco CallManager Extension Mobility, 
page 3-19
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Configuring Cisco CallManager for Cisco CallManager 
Extension Mobility

To configure Cisco CallManager for Extension Mobility, perform the following 
procedures:

1. Adding the Login Service, page 3-19

2. Adding the Logout Service, page 3-21

3. Setting the Service Parameters, page 3-23

4. Creating the Default Device Profile for a User, page 3-26

5. Associating a User Device Profile to a User for Cisco CallManager 
Extension Mobility, page 3-28

6. Configuring the Cisco IP Phones for Cisco CallManager Extension Mobility, 
page 3-30

Adding the Login Service

To add the Login Service for Cisco CallManager Extension Mobility, perform the 
following steps:

Procedure

Step 1 On the Cisco CallManager server, choose 
Start > Programs > Cisco CallManager 3.1 > Administration.

Step 2 Select Feature. 

Step 3 Use the drop-down arrow to select Cisco IP Phone Services.

Step 4 At the Service Name field, enter a name for the service which will identify it for 
the user (for example, Login).
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Step 5 At the Service URL field, enter the IP address of the application engine and the 
HTTP trigger you created in Step 3 of the “Adding the Login Application” section 
on page 3-10 (for example, http://AppServerIP: 8080/login).

Caution The URL is case-sensitive. Make sure you enter the exact name you entered 
for the Login Application Trigger.

Tips Always use port 8080. 

See Figure 3-9.

Figure 3-9 Adding the Login Service

Step 6 Click Insert and click Update.
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Related Topics:

• Adding the Login Application Trigger, page 3-15

• Adding the Logout Service, page 3-21

• Setting the Service Parameters, page 3-23

Adding the Logout Service

To add the Logout Service for Cisco CallManager Extension Mobility, perform 
the following steps:

Procedure

Step 1 On the Cisco CallManager 3.1 > Administration page, select Feature.

Step 2 Use the drop-down arrow to select Cisco IP Phone Services. 

Step 3 At the Service Name field, enter a name for the service which will identify it for 
the user (for example, Logout).

Step 4 At the Service URL field, enter the IP address of the application engine and the 
HTTP trigger you created in Step 3 of Adding the Logout Application, page 3-13 
(for example, http://AppServerIP: 8080/logout).

Caution The URL is case-sensitive. Make sure you enter the exact name you entered 
for the Logout Application Trigger.

Tips Always use port 8080.

See Figure 3-10.
3-21
Cisco CallManager Extended Services Administrator’s Guide

78-12959-01



Chapter 3 Configuring Cisco CallManager Extension Mobility
Procedures for Configuring Cisco CallManager Extension Mobility
Figure 3-10 Adding the Logout Service

Step 5 Click Insert and click Update.

Related Topics:

• Adding the Login Service, page 3-19

• Setting the Service Parameters, page 3-23
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Setting the Service Parameters

Setting the Service Parameters in the CallManager Service Parameters 
Configuration page allows you to define the maximum login time and the multi 
login behavior for Cisco CallManager Extension Mobility. 

Maximum Login Time

At the Enforce Maximum Login Time, set True or False. True indicates you wish 
to define a maximum login time.

At the Maximum Login Time field, enter the maximum login time. This is a 
system-wide maximum time specified for logins. After this time, the system 
automatically logs out the device.

Note The automatic logout service is used for all logins if a system maximum login 
time is specified. Each login will then have an automatic logout set up for the 
maximum duration.

Multi Login Behavior

At the Multi Login Behavior field, select one of the following options:

• Multiple Logins Allowed: A user can log into more than one device at a time.

• Multiple Logins Not Allowed: The second and subsequent login attempts 
after a user logs in once successfully will fail.

• Auto Logout: When a user logs into a second device, they are automatically 
logged out of the first device.

• The default value is Multiple Logins Not Allowed.
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To set the Service Parameters for Cisco CallManager Extension Mobility, 
perform the following steps:

Procedure

Step 1 On the Cisco CallManager 3.1 > Administration page, select Service > Service 
Parameters. 

The Service Parameters Configuration page displays

Step 2 From the pull-down menu, select the server address of your Cisco CallManager.

A new Service Parameters Configuration page displays.

Step 3 From the Services list box on the left side of the page, choose Cisco Extension 
Mobility (see Figure 3-11).

Figure 3-11 Selecting the Logout Service
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A new Service Parameters Configuration page displays. 

Figure 3-12 shows the Service Parameters screen, with the service parameter 
information entered.

Figure 3-12 Setting the Service Parameters

Step 4 At the Login Service Enabled field, select True to enable the user login service.
The default value is True. Selecting false disables the user login service.

Step 5 At the Enforce Maximum Login Time, set True or False. 
If you select True, the service logs a user out of a device automatically after a 
maximum login time. 
The default value is False.

Step 6 At the Maximum Login Time field, enter the maximum login time 
(Hours:Minutes) from 1 to 168:00 (one minute to one week). 
The default value is 8:00 (8 hours).
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Step 7 At the Multi Login Behavior field, select one of the following responses:

• Multiple Logins Allowed: A user can log into more than one device at a 
time.

• Multiple Logins Not Allowed: The second and subsequent login attempts 
after a user successfully logs in once will fail.

• Auto Logout: After a user logs into a second device, he is automatically 
logged out of the first device.
The default value is Multiple Logins Not Allowed.

Step 8 Click Update.

Related Topics:

• Adding the Login Service, page 3-19

• Adding the Logout Service, page 3-21

• Creating the Default Device Profile for a User, page 3-26

Creating the Default Device Profile for a User

The Default Device Profile contains attributes such as name, description, phone 
template, add-on modules, directory numbers, subscribed services, and speed dial 
information. 

Note Before proceeding, you must have a device profile name and phone button 
template(s) configured. Refer to the Cisco CallManager Configuration Guide.

To add a default device profile for a new user of Cisco CallManager Extension 
Mobility, follow these steps:

Procedure

Step 1 On the Cisco CallManager Administration page, choose Device > Device Profile.
The page refreshes to the Find and List Device Profiles Page.

Step 2 Choose the Add a New User Device Profile link in the upper right-hand corner. 
The User Device Profile Configuration page displays.
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Step 3 At the User Device Profile Name field, enter a name of your choice for the device 
profile. This text can be anything that describes this particular user device profile.

Step 4 In the Phone Button Template field, for both the Cisco IP Phone Models 7960 and 
7940, select Default 7960 from the Phone Button Template drop-down list. The 
default applies to both Cisco IP Phones. See Figure 3-13.

Figure 3-13 Associating a User Device Profile to a User

Step 5 You can configure one or two Cisco IP Phone Expansion modules for this device 
profile by choosing from the add-on module drop-down lists. 

Note You may view a phone button list at any time by choosing the View button list 
link next to the phone button template fields. A separate window pops up, 
displaying the phone buttons for that particular expansion module.

Step 6 Click Insert.

The Directory Number Configuration page appears. 

Step 7 At the Directory Number field, enter the directory number and click Insert.
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Step 8 The following prompt appears: The Directory Number has been assigned to the 
current device. Click OK to return to the current device.

Click OK.

Step 9 The page refreshes back to the User Device Profile Configuration page for this 
device profile.

On the User Device Profile Configuration page, select Update service.

Step 10 To update services, select the service which you added in the “Adding the Logout 
Service” section on page 3-21.

Step 11 Click Continue.

Step 12 Click Subscribe.

Related Topics:

• Adding the Logout Service, page 3-21

• Associating a User Device Profile to a User for Cisco CallManager 
Extension Mobility, page 3-28

Associating a User Device Profile to a User for Cisco CallManager 

Extension Mobility

A User Device Profile is associated in the same way that physical devices are 
associated, starting with the User Global Directory. To associate a user device 
profile to a user for Cisco CallManager Extension Mobility, follow these steps:

Procedure

Step 1 On the Cisco CallManager Administration page, choose 
User > Add a New User.

Step 2 At the Add a New User screen, enter the first name (for example, jean), last name 
(for example, brody), and UserID (for example, jbrody).

Step 3 At the User Password and Confirm Password fields, enter a password of your 
choice.

Step 4 At the PIN field, enter a numeric Personal Identification Number (PIN) of your 
choice. Confirm the PIN number.
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Step 5 To save your changes and add the user, click Insert.

Step 6 From the left pane, select Extension Mobility (see Figure 3-14).

Figure 3-14 Associating a User Device Profile to a User 

Step 7 Click Select Profiles to display the profile that you created in the “Creating the 
Default Device Profile for a User” section on page 3-26.

Step 8 Scroll and click on the box next to the default profile to select the appropriate 
profile.

Note The first profile checked becomes the default profile.

Step 9 Click Update.
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Related Topics:

• Creating the Default Device Profile for a User, page 3-26

• Configuring the Cisco IP Phones for Cisco CallManager Extension Mobility, 
page 3-30

Configuring the Cisco IP Phones for Cisco CallManager Extension Mobility

To configure the Cisco IP phone for Cisco CallManager Extension Mobility, 
follow these procedures:

• Configuring the Cisco IP Phone Models 7960 and 7940, page 3-30

• Subscribing to the Cisco CallManager Login Service, page 3-32

Configuring the Cisco IP Phone Models 7960 and 7940

To configure a new or an existing Cisco IP Phone Model 7960 or 7940 for 
Cisco CallManager Extension Mobility, follow these steps:

Procedure

Step 1 On the Cisco CallManager Administration page, choose Device > Phone. 

The Find and List Phones page displays. 

Step 2 To configure an existing phone, perform the following steps:

a. Choose the fields you want to use to locate a phone. See the 
Cisco CallManager Administration Guide for more information.

Note To find all phones registered in the database, choose Device Name 
from the list of fields, and choose “is not empty’ from the list of 
patterns; then, click Find.

A list of devices matching the criteria appears. 

b. Select the box next to the device you want to configure and click on the 
device.

c. Proceed to Step 4.
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Step 3 To configure a new phone, perform the following steps:

a. Click Add a New Phone in the top right corner.

The Add a New Phone page displays.

b. Use a drop-down arrow to select your phone type: Cisco 7960 or Cisco 7940. 

c. Click Next.

d. Proceed to Step 4.

Step 4 The Phone Configuration page displays (see Figure 3-15). 

Figure 3-15 Configuring a Phone for Cisco CallManager Extension Mobility
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At the Phone Configuration page, enter the Media Access Control (MAC) address 
of the phone.

Note The MAC address of the phone can be found on the back of the unit on the 
label next to the word MAC. It can also be found by using the Settings button 
on the Phone (79XX), then selecting Network Configuration. Under 3 MAC 
Address, the phone’s MAC address appears.

Step 5 Fill in the remaining parameters as required.

Step 6 Click Insert when you are finished.

Step 7 You will see a pop-up prompt: The phone has been inserted in the database. Would 
you like to add a directory number for line 1 of the phone now.

Click OK.

The Directory Number Configuration page displays.

Step 8 Enter the DN of the phone you are configuring at the Directory Number field.

Step 9 Click Insert.

Step 10 Click Update.

Step 11 You will see a pop-up prompt: Reset the phone to have the changes take effect.
Click OK.

Step 12 Proceed to the “Subscribing to the Cisco CallManager Login Service” section on 
page 3-32.

Subscribing to the Cisco CallManager Login Service

To subscribe to the Cisco CallManager Login Service, follow these procedures:

Procedure

Step 1 On the Cisco CallManager Phone Configuration page, select Update Services.

Step 2 From the drop-down arrow, select the service (for example, login) which you 
added in the “Adding the Login Service” section on page 3-19. 

Step 3 Click Continue.
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Step 4 Click Subscribe. Close the window.

Step 5 On the Cisco CallManager Phone Configuration page, scroll down to the bottom 
of the page. Click the check box to Enable Extension Mobility Feature (see 
Figure 3-16).

Figure 3-16 Enabling Extension Mobility

Step 6 At the Log Out Profile field, select Use Current Device Settings.

This creates an Autogenerated Device Profile as the default device profile. When 
a logout is executed, the current configuration (the User Device Profile) is 
replaced by the Autogenerated Device Profile (the default device profile).

See the “Rules for Configuring Cisco CallManager Extension Mobility” section 
on page 3-1 for information about configuring device profiles.

Step 7 The remaining fields show the current device information regarding the login 
status of the device: Log in UserID; Log In Time; Log Out Time.

Step 8 Click Update.

Related Topics:

• Configuring the Cisco IP Phones for Cisco CallManager Extension Mobility, 
page 3-30

• Preparing the User for Cisco CallManager Extension Mobility, page 3-35
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Setting up Anonymous Access on IBM-340 platforms

If you are configuring Cisco CallManager Extended Services on an IBM-340 
platform, make sure that the system is set to allow anonymous access to the Login 
Service web site. If your system is not set to allow anonymous access, you may 
encounter a Login Server Connection Error when attempting to log in to the 
phone.

To allow anonymous access, set the IIS to control the password. Perform the 
following steps:

Procedure

Step 1 On the Cisco CallManager server, choose 
Start  > Programs > Administrative Tools > Internet Services Manager.

Step 2 Expand the tree on the left side of the page: machine name > Default Web 
Site > LoginService

Step 3 Right click LoginService in the left pane and select Properties.

Step 4 Click the Directory Security tab.

Step 5 Under Anonymous access and authentication control, click the Edit button.

Step 6 Make sure that Anonymous access is checked. Click Edit for the account used 
for anonymous access.

Step 7 Verify that “Allow IIS to control password” is checked.

Step 8 Click OK.

Step 9 Click OK.

Step 10 Close Internet Services Manager.
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Preparing the User for Cisco CallManager 

Extension Mobility
Once you have configured the system for Cisco CallManager Extension Mobility, 
provide the phone user with the following information:

• notification of the feature’s availability

• the name you have given the login service and logout service for 
Cisco CallManager Extension Mobility (for example, login service and 
logout service)

• their password, UserID and PIN

• the URL for the Cisco IP Phone Menu Options web page for the user to 
change their password and PIN 

• instructions on logging in and logging out, including any information on 
Service Parameters you have set defining login and logout (see Setting the 
Service Parameters, page 3-23)

You can provide the following procedures to the phone user to enable them to use 
the Cisco CallManager Extension Mobility feature:

• Logging in to Cisco CallManager Extension Mobility, page 3-36

• Logging out of Cisco CallManager Extension Mobility, page 3-37
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Logging in to Cisco CallManager Extension Mobility
To log in to Cisco CallManager Extension Mobility, perform the following steps:

Procedure

Step 1 From a Cisco IP 7960/7940 Phone, press the services button.

Step 2 From the list of displayed services, select the login service defined by your 
administrator for Cisco CallManager Extension Mobility (for example, login 
service).

Step 3 The phone prompts you to enter your UserID and Personal Identification Number 
(PIN).

Step 4 Click Submit to access your login service or click Cancel to exit.

The phone adopts your user device profile information such as directory 
number(s), speed dials and services.

Note Your administrator provides you with your password, UserID, PIN, and the 
URL for your Cisco IP Phone User Options web page. To change your 
password and PIN, go to the web page and follow the instructions.

Step 5 Proceed with using the phone.
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Logging out of Cisco CallManager Extension Mobility
To log out of Cisco CallManager Extension Mobility, perform the following 
steps:

Procedure

Step 1 From a Cisco IP 7960/7940 Phone, click on the Services button.

Step 2 From the list of displayed services, select the logout service defined by your 
administrator for Cisco CallManager Extension Mobility (for example, logout 
service).

Step 3 The phone returns to its original user device profile.
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Configuring Cisco CallManager 
AutoAttendant

This section provides information about configuring Cisco CallManager and the 
Cisco Customer Response Application Engine (Cisco CRA Engine) in 
preparation for deploying your Cisco CallManager AutoAttendant 
(Cisco CallManager AA).

Perform the following procedures to configure your Cisco CallManager AA:

1. Configuring Cisco CallManager for Cisco CallManager AutoAttendant, 
page 4-2

2. Configuring the Cisco CRA Engine for Cisco CallManager AutoAttendant, 
page 4-6

3. Customizing Cisco CallManager AutoAttendant, page 4-12
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Configuring Cisco CallManager for 
Cisco CallManager AutoAttendant

Before you can use Cisco CallManager AutoAttendant (Cisco CallManager AA), 
you must configure Cisco CallManager. The following steps illustrate the basic 
configuration principles and describe a simple configuration to test your 
installation.

1. Adding CTI Route Points in Cisco CallManager, page 4-2

2. Adding CTI Ports in Cisco CallManager, page 4-3

3. Creating a Cisco CallManager User for Cisco CallManager AutoAttendant, 
page 4-4

Adding CTI Route Points in Cisco CallManager
To add a CTI route point in Cisco CallManager for Cisco CallManager 
AutoAttendant (Cisco CallManager AA), perform the following steps:

Procedure

Step 1 On the Cisco CallManager server, choose 

Start > Programs > Cisco CallManager 3.1 > CallManager Administration.

You can also connect to the Cisco CallManager web server using any computer on 
your network by using the following URL:

http://servername/ccmAdmin

where servername is the DNS name or IP address of your Cisco CallManager 
server.

You will be prompted for a network username and password.

Step 2 Choose Device > Add a New Device.

Step 3 Use the Device Type drop-down arrow to select CTI Route Point.

Step 4 Click Next.

Step 5 In the Device Name field, enter a name of your choice for the CTI route point. 
Choose a name that is descriptive.
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Step 6 In the Device Pool field, select the device pool for this CTI route point. If no other 
pool has been created, select Default.

Step 7 Click Insert.

Step 8 In the left pane of the CTI Route Point Configuration window, click 
Line 1-click to add.

Step 9 In the Directory Number field, enter the directory number for this CTI route point. 
This is the number that users will dial to reach this CTI route point (for example, 
4000).

Step 10 Click Insert and Close. Now you need to add CTI ports to Cisco CallManager.

Adding CTI Ports in Cisco CallManager
All CTI ports in a CTI port group must have consecutive directory numbers. For 
example, if you want four CTI ports in a particular CTI port group, and the first 
is number 9001, the rest of the ports will automatically be configured 9002 
through 9004.

To add CTI ports in Cisco CallManager, perform the following steps:

Procedure

Step 1 On the Cisco CallManager server, choose 
Start > Programs > Cisco CallManager 3.1 > CallManager Administration

You can also connect to the Cisco CallManager web server using any computer on 
your network by using the following URL:

http://servername/ccmAdmin

where servername is the DNS name or IP address of your Cisco CallManager 
server.

Step 2 Choose Device > Add a New Device.

Step 3 Use the Device Type drop-down arrow to select Phone and click Next.

Step 4 Use the Phone Type drop-down arrow to select CTI Port and click Next.

Step 5 In the Device Name field, enter a name for the device (for example, CTI_Port1).
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Step 6 Use the Device Pool drop-down arrow to select the device pool for this CTI port. 
If there is no other pool, select Default.

Step 7 Click Insert.

Step 8 In the left pane of the Phone Configuration window, click Line 1 - click to add.

Step 9 In the Directory Number field, enter the directory number of this CTI port (for 
example, 4001).

Note CTI port groups must contain sequential CTI port directory numbers.

Step 10 Click Insert and Close.

You can continue to add ports using consecutive numbers. After you have added 
and configured CTI ports for Cisco CallManager AA, configure a 
Cisco CallManager user for the Cisco CallManager AA.

Creating a Cisco CallManager User for 
Cisco CallManager AutoAttendant

To create a Cisco CallManager user for Cisco CallManager AutoAttendant 
(Cisco CallManager AA), perform the following steps:

Procedure

Step 1 On the Cisco CallManager server, choose 
Start > Programs > Cisco CallManager 3.1 > CallManager Administration.

You can also connect to the Cisco CallManager web server by using the following 
URL:

http://servername/ccmAdmin

where servername is the DNS name or IP address of your Cisco CallManager 
server.

You will be prompted to enter the network password.

Step 2 Choose User > Add a New User.
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Step 3 In the Add a New User page, enter the first name (for example, JTAPI), last name 
(for example, User), and UserID (for example, JTAPIUser).

Step 4 Enter a password of your choice in the User Password and Confirm Password 
fields.

Step 5 At the PIN field, enter a numeric Personal Identification Number (PIN) of your 
choice. Confirm the PIN number.

Step 6 Click the Enable CTI Application Use check box.

Caution When you create a Cisco CallManager user for 
Cisco CallManager AA, you must click the 
Enable CTI Application Use check box on the Cisco CallManager 
Add a New User page. If you do not click the Enable CTI 
Application Use check box, the Cisco CRA Engine will be unable 
to receive calls from Cisco CallManager.

Step 7 Click Associate Devices.

Step 8 In the User Devices Assignment Window, check the boxes associated with the 
Device Name fields. 

In order to use the examples provided here, check the following items.

• AA_RP

• CTI_Port1

• CTI_Port2

Step 9 Make sure the No Primary Extension radio button is selected.

Step 10 Click Insert.
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Configuring the Cisco CRA Engine for 
Cisco CallManager AutoAttendant

Once you have configured Cisco CallManager for Cisco CallManager 
AutoAttendant, configure the Cisco Customer Response Application 
(Cisco CRA) Engine to communicate with Cisco CallManager and the 
Cisco IP Telephony Directory. To do this, perform the following procedures:

1. Configuring Directory Information, page 4-6

2. Configuring the JTAPI Subsystem on the Cisco Customer 
Response Application Engine, page 4-9

3. Adding a CTI Port Group, page 4-10

4. Adding a New Cisco CallManager AutoAttendant, page 4-10

Configuring Directory Information
The Cisco IP Telephony Directory server stores two types of information used by 
your Cisco Customer Response Application (Cisco CRA) Engine. First, it stores 
directory information, which includes CTI port and routing configurations. 
Second, it contains the repository subdirectory, which stores the applications you 
create with the Cisco CRA Engine.

If your Cisco IP Telephony solution includes one application server and one 
Cisco IP Telephony directory, the directory configuration information will be the 
same for both the directory and the repository.

It is also possible for the application server to receive directory information from 
one Cisco IP Telephony Directory and application script from a repository on 
another server. In this scenario, the directory and repository would have different 
configurations.
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For efficient management of resources, each type of configuration is stored as a 
profile on the Cisco IP Telephony Directory server. In the event of a system failure 
or reallocation of application servers, you can upload a directory profile from the 
Cisco IP Telephony Directory to a replacement application server. 

Note Directory profiles can only be used by one application server at a 
time.

Repository profiles can be used to centralize the storage of application script. 
Unlike directory profiles, repository profiles may be shared by more than one 
application server.

To configure Directory information on the application server, perform the 
following steps:

Procedure

Step 1 Connect to the Application Administration web server by using the following 
URL:

http://servername/AppAdmin

where servername is the DNS name or IP address of your application server.

If you are using the computer that is running the application server, you can 
connect to the web pages by choosing: 

Start > Programs > Cisco CRA Administrator 
> Application Administration.

You will be prompted to enter the network username and password.

Step 2 At the Cisco Customer Response Setup page, click Setup.
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Step 3 Use Table 4-1 to fill in the fields.

Step 4 Click the Initialize profile check box and click OK.

Step 5 At the Install Application Scripts Installation completed prompt, click 
Main Menu.

Step 6 If you want to maintain separate profiles for your directory and repository 
configurations, click the Use a Different Repository Profile check box.

Note By default, the application server will use the directory 
configuration information to build the application repository 
configuration.

Table 4-1 Directory Configuration

Field Description Default for DC Directory

Directory hostname Hostname or IP address of the Cisco IP 
Telephony Directory server used by the current 
Application Engine profile. 

Directory port number The port number of the Cisco IP Telephony 
Directory.

8404

Directory user (DN) The user name (also called the distinguished 
name) configured on the directory server for the 
user that has permission to modify the 
Cisco IP Telephony tree and object entries.

cn=Directory Manager, 
o=cisco.com

Directory password The password for the Directory user. ciscocisco

Base Context The branch of the Cisco IP Telephony Directory 
tree that contains the Cisco configuration 
information.

o=cisco.com

Server Type The type of LDAP directory—MS Active 
Directory, Netscape Directory Server 4.0, or DC 
Directory.

DC Directory

Configuration Profile 
Name

The profile name that identifies this engine 
configuration.
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Step 7 Click Update to enter your changes.

If you clicked the Use a Different Repository Profile check box, the repository 
configuration window appears. Complete these fields with the configuration 
information appropriate for your repository directory.

Configuring the JTAPI Subsystem on the Cisco Customer 
Response Application Engine

After you complete the directory configuration, you must configure the JTAPI 
subsystem on the Cisco Customer Response Application Engine 
(Cisco CRA Engine). The Cisco CRA Engine uses the JTAPI subsystem to send 
and receive calls from Cisco CallManager.

To configure the JTAPI Subsystem, perform the following steps:

Procedure

Step 1 At the Application Administration Main Menu, click the JTAPI link in the 
Options column.

Step 2 In the CallManager field, enter the IP address or DNS name of the Cisco MCS 
running Cisco CallManager.

Step 3 In the Username field, enter the Cisco CallManager UserID you defined in 
“Creating a Cisco CallManager User for Cisco CallManager AutoAttendant” 
section on page 4-4 (for example, JTAPIUser).

Step 4 Enter the password you defined for this UserID in the Password field.

Step 5 Click Update to enter your changes.
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Adding a CTI Port Group
To add a CTI Port Group, perform the following steps:

Procedure

Step 1 On the JTAPI configuration page, click the Add new CTI Port Group link.

Step 2 On the Add a new CTI Port Group page, use the Type drop-down arrow to select 
Applications and click Next.

Step 3 On the CTI Port Group Configuration page, enter 1 in the Number field.

Step 4 In the Initial CTI Port field, enter the first CTI Port directory number you 
established in Step 11 of the “Adding CTI Ports in Cisco CallManager” section 
on page 4-3. If you are using the provided sample values, enter 4001.

Step 5 In the Last CTI Port field, enter the CTI Port directory number of the last CTI port 
you defined in Cisco CallManager. If you are using the provided sample values, 
enter 4004.

Note CTI port groups must contain sequential CTI port directory numbers.

Step 6 Click Update.

Adding a New Cisco CallManager AutoAttendant
When you have configured the appropriate subsystem on the Cisco Customer  
Response Application (Cisco CRA) Engine, you can use one of the sample scripts 
to create an application and start the Cisco CRA Engine. 
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To add a new Cisco CallManager AutoAttendant, perform the following steps:

Procedure

Step 1 Connect to the Application Administration web server by using the following 
URL:

http://servername/AppAdmin

where servername is the DNS name or IP address of your Cisco CRA Engine.

Step 2 At the Application Administration Main Menu, click the Telephony Application 
link in the Options column.

Step 3 Click the Add New Application link on the Application page.

Step 4 At the Application Configuration page, use the drop-down arrow to select the 
aa.aef script. The system populates the Script Name field with “aa.aef.” Click 
Next. 

Step 5 Enter a name for the application in the Application Name field.

Step 6 At the Application Parameters Configuration page, provide the CTI route point 
for this Application (for example, 4000).

Step 7 In the Maximum Number of Sessions field, enter the number of CTI ports you 
added in Cisco CallManager. If you are using the provided sample values, enter 4.

Step 8 In the OperExtn field, enter the extension of the phone that will be used by the 
human operator and click Update.

Step 9 Select Main Menu > Engine.

Step 10 On the Engine page, click Start.

When the Engine status is running and the subsystems indicate they are in 
service, the Cisco CallManager AA is functional. You can call into the 
Cisco CallManager AA by dialing the directory number of the CTI route point 
you added to Cisco CallManager. If you are using the provided sample values, dial 
4000.
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Customizing Cisco CallManager AutoAttendant
By default, Cisco CallManager AA plays back a prerecorded welcome prompt 
and spells out user names. You can customize your Cisco CallManager AA by 
adding your own welcome prompt and recordings of your users’ spoken names:

• Configuring an Instance of Cisco CallManager AutoAttendant, page 4-12

• Configuring Prompts, page 4-13

Configuring an Instance of Cisco CallManager AutoAttendant
To configure an existing Cisco CallManager AutoAttendant 
(Cisco CallManager AA), perform the following steps:

Procedure

Step 1 Select Applications from the application administration main menu.

Step 2 Select the instance of Cisco CallManager AA that you wish to configure and click 
Next.

Step 3 You can make the following configuration changes:

• Application Name—the name of the application.

• CTI Route Point—the number used to reach this application.

• Maximum Number of Sessions—the maximum number of sessions possible 
for this application.

• Enabled—whether the application is enabled or not.

• operExtn—the extension of the phone that will be used by the human 
operator.

• welcomePrompt—the prompt used as the welcome prompt for 
Cisco CallManager AA. See the “Configuring the Welcome Prompt” section 
on page 4-15 for information about how to upload prompts.
4-12
Cisco CallManager Extended Services Administrator’s Guide

78-12959-01



Chapter 4 Configuring Cisco CallManager AutoAttendant
Customizing Cisco CallManager AutoAttendant
Configuring Prompts
The Media Configuration page also allows you to upload new prompts to the 
Cisco CRA Engine, modify existing prompts, and configure the UDP port.

The following topics are included:

• General Media Configuration, page 4-13

• Recording the Welcome Prompt, page 4-14

• Configuring the Welcome Prompt, page 4-15

• Uploading a Spoken Name, page 4-16

• Uploading a Batch of Spoken Names, page 4-17

General Media Configuration

The General Media Configuration page shows the two directory paths that the 
Cisco CRA Engine uses to store System and User prompts, and the Starting UDP 
Port field.

The prompt path information shown on the General Media Configuration page is 
for your information only. You cannot modify these paths. System prompts are 
general-use type prompts, and many are included with Cisco CRA. (You may also 
record your own). User prompts are the prompts you create for specific 
applications.

The Starting UDP port field is used to specify the first UDP port for sending and 
receiving UDP data. Cisco Customer Response Applications uses the User 
Datagram Protocol (UDP) protocol to send and receive media packets over the IP 
network. The Starting UDP port field is pre-populated with a default value. The 
default value for this field corresponds to the normal configuration for Cisco 
networking equipment and ensures the highest possible audio quality for calls to 
Cisco Customer Response Applications.
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Recording the Welcome Prompt

You can record prompts for Cisco CallManager AA on any computer using 
Microsoft Sound Recorder. Save the prompt as a .wav file in CCITT (µ -law) 
8kHz, 8-bit, Mono format. (You can use another audio application to record the 
welcome prompt if it supports this format.)

To record a prompt using Microsoft Sound Recorder, perform the following steps:

Procedure

Step 1 Select the following option from the Windows Start menu:

Programs > Accessories > Multimedia > Sound Recorder. 

Step 2 Click the Record button (red), and record your greeting into the microphone. 

Step 3 Click the Stop button (black) when you have finished recording.

Step 4 To check your greeting:

a. Click the Rewind button (left-pointing arrows) or drag the slider back to the 
beginning of the recording.

b. Click the Play button (right-pointing arrow) button.

Step 5 When you are satisfied with your greeting, save the recording.

a. Select File > Save As. 

b. Click Change to set the recording options. (You can also do this by selecting 
Properties from the Sound Recorder File menu).

Figure 4-1 Sound Selection Window

33
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7
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c. Use the Format drop-down arrow, select CCITT µ-law.

d. Use the Attributes drop-down arrow to select 8.000 kHz, 8 Bit, Mono 7 
kb/sec.

e. Click Save As and enter a name for this format.

f. Click OK to close the Sound Selection window.

g. Browse to the directory of your choice, preferably a directory that you have 
set aside for prompts.

h. Enter the file name, and click Save.

Configuring the Welcome Prompt

The Media Configuration Page allows you to upload new prompts, or to modify 
existing prompts stored on the Cisco CRA Engine.

To add or modify prompts, perform the following steps:

Step 1 On the Application Administration Main Menu, click Media. The system displays 
the Media Subsystem Configuration page.

Step 2 Click the Prompts link. The system displays the Prompt Configuration page.

Step 3 To replace an existing prompt with a new .wav file, click the arrow in the Upload 
column for the prompt you want to modify. To create a new prompt, click the Add 
a new prompt link. The system displays the Prompt File Name page.

Step 4 Enter the name of the .wav file you want to use to replace the existing prompt, or 
to use as a new prompt. If you are adding a new prompt, enter a name for the 
prompt as it resides on the Cisco application server.

Step 5 When you have provided the .wav file and prompt name information, click 
Upload.
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Uploading a Spoken Name

To upload Cisco CallManager AutoAttendant (Cisco CallManager AA) spoken 
names in your users' voices, upload the corresponding .wav files into the 
Directory:

Procedure

Step 1 Ask users to record their names in the manner prescribed in the “Recording the 
Welcome Prompt” section on page 4-14, and to save their files as userId.wav, 
where userId is their user name. 

Step 2 Using the Cisco application server computer (this process cannot be done 
remotely), connect to the spoken name web page with the following URL:
http://servername/SpokenNameUpload
where servername is the DNS name or IP address of your application server.

You can also choose Start > Programs > Cisco IP IVR > SpokenNameUpload. 

Step 3 Click the Change button and click OK.

Step 4 Click the Browse button to locate the spoken name wav file you would like to 
upload. The Choose file navigation window appears.

Step 5 When you have located the appropriate file, click Open.

Step 6 Confirm that you have identified the appropriate path and file and click Upload.
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Uploading a Batch of Spoken Names

If you need to upload a large number of spoken names at once, use the 
SpokenNameBulkUpload.bat utility, provided on the application server. To 
upload a batch of spoken names, perform the following steps:

Procedure

Step 1 Ask users to record their names in the manner prescribed in the “Recording the 
Welcome Prompt” section on page 4-14, and to save their files as userId.wav, 
where userId is their user name. 

Step 2 Collect these files in a directory on the Cisco application server computer.

Step 3 Upload the contents of the local directory to your Cisco IP Telephony Directory 
using the following DOS command:
SpokenNameBulkUpload directory true|false

where directory is the directory on your hard drive where the .wav files are 
located.

Use the true|false parameter to choose to replace existing spoken names in the 
Cisco IP telephony directory or not:

• true—replaces any spoken name .wav files in the directory with spoken name 
.wav files of the same name.

• false—does not replace spoken name .wav files in the directory with spoken 
name .wav files of the same name.
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Administering Cisco CallManager 

Extended Services

This section provides information about managing the Cisco CallManager 
Extended Services after you have configured the services.Topics include:

• Managing the Cisco CRA Engine, page 5-1

• Using Cisco CRA Real-time Reporting, page 5-8

• Using Cisco CRA Historical Reporting, page 5-13

Managing the Cisco CRA Engine
When you click the Engine link on the Application Administration main menu, 
the system displays the Engine Control page.

The Engine Control displays the state of the Cisco Customer Response 
Application (Cisco CRA) Engine and the Cisco CRA subsystems. It also allows 
you to start and stop the application engine. You may need to stop the application 
engine for system changes or upgrades or for troubleshooting purposes.

Use the links on the Engine Control page to perform the following operations:

• Starting and Stopping the Cisco CRA Engine, page 5-2

• Changing Engine Configuration, page 5-3

• Setting Trace File Options, page 5-4
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Starting and Stopping the Cisco CRA Engine
You can use the Cisco Customer Response Application (Cisco CRA) 
Administration web pages to start and stop the Cisco CRA Engine. You can also 
control the Cisco CRA Engine from the service panel in the Administrative Tools 
portion of the Windows NT control panel.

To start and stop the application engine from your web browser, perform the 
following steps.

Procedure

Step 1 Access the Application Administration main menu, by entering the following 
URL in the Location field of your browser:

http://<servername>/AppAdmin

where servername is the Domain Name Service (DNS) name or IP address of your 
application server.

Alternatively, if you are on the application server computer, you can choose

Start > Programs > Cisco CRA Administrator > Application 
Administrator.

The system displays the Application Administration main menu.

Step 2 To go to the Engine Control page, click Engine. 

The Engine Control page provides specific information about each application 
session, such as the start time and the parties involved.

Step 3 To start the engine, click Start Engine.

This link starts the Windows service, “Cisco Application Engine.” 

Note The status may display “Starting” for as long as 10 to 30 seconds.

Step 4 To shut down the application engine, click Stop Engine.
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Changing Engine Configuration
To modify the engine parameters for the profile you have chosen, perform the 
following steps:

Procedure

Step 1 Select Engine > Configure from the Application Administration main menu. 

The system displays the Engine Configuration page.

Step 2 To configure the engine, enter the appropriate values in the fields described in 
Table 5-1. 

Step 3 Click Update to save the changes.

Table 5-1 Engine Configuration

Field Description

RMI Port Number The port number used by the engine to serve remote 
method invocation (RMI) requests.

Maximum Number of 
Executed Steps

Do not change the default value.

This is the maximum number of steps any script is 
allowed to execute before the engine terminates the 
application. It is intended to prevent a script from 
running “infinitely” long.

Maximum Number of 
Concurrent Sessions

Maximum number of concurrent tasks. If a call 
arrives while all sessions are running, it is delayed 
until a session is free. 
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Setting Trace File Options
Trace files are logs that record application engine activity. You can use the trace 
file to identify system or application script problems. Because recording all 
information about engine activity can create a file that is large and difficult to 
read, you can specify to the trace file which items you want to record. 

This section describes how you perform the following tasks:

• Configuring the Trace File, page 5-4

• Setting Trace Level Options, page 5-5

• Viewing Trace Files, page 5-7

Configuring the Trace File

To configure the Trace File options, perform the following steps:

Procedure

Step 1 Select Engine > Trace Configuration from the Application Administration main 
menu. 

The system displays the Trace File Options page.

Step 2 To configure trace files and syslog files, enter the appropriate values in the fields 
described in Table 5-2.

Table 5-2 Trace file options

Field or option Description

Trace File Output Enable this check box to store trace file 
output in the filename specified below.

Filename The “base” trace file name. Filenames 
consist of the base name plus the file 
number (for example,. 
CiscoMIVR001.log).
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Step 3 Click Update to save your changes.

Setting Trace Level Options

The Trace Configuration page also provides a series of check boxes that set the 
trace level for various engine activities. The trace levels are as follows:

• Debug—most verbose, to be used primarily for debugging and 
troubleshooting.

• Informational—describes the transition state (for example,. system start, 
system stop)

• Notification—notifies the user that something has happened (for example,. 
maximum number of sessions exceeded)

• Warning—notifies the user of error conditions that can be recovered from and 
that do not result in loss of service

Two groups of trace level activity options; active and inactive. You can make 
changes to the parameters of the active options without restarting the Application 
Engine, and the trace file will reflect your changes. The inactive options require 
that you restart the application engine to reflect any changes you made.

Number of Trace Files The number of trace files to rotate.

When the last file is reached, the trace 
file re-starts from “1”. If the engine is 
restarted, tracing is re-started in the 
first file.

Trace File Size The maximum size (in bytes) of the 
trace file. After the file reaches this 
size, the system moves to the next file.

Table 5-2 Trace file options (continued)

Field or option Description
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Table 5-3 summarizes the active engine activities that you can monitor.

 
Table 5-3 Active Trace level activity options

Field or option Description

ADM Administration Client

APP_MGR Application Manager

ENG Application Engine

GENERAL_STEPS General Steps

ICD_HDM ICD Historical Data Manager

ICD_RTDM ICD Real Time Data Manager

LIB_LDAP LDAP Library

LIB_MEDIA Media Library

LIB_RMI Remote Message Interface 
(RMI) Library

LOG_MGR Log Manager

RPT Reporting 

SS_APP Application Subsystem

SS_CM Contact Manager Component

SS_DB Database Subsystem

SS_EMAIL Email Subsystem

SS_HTTP HTTP Subsystem

SS_RM Resource Manager Component

SS_RMCM Resource Manager Contact 
Manager Subsystem

SS_TEL JTAPI Subsystem (Telephony)

STEP_CALL_CONTROL Call Control Steps

STEP_ICD ICD Steps

STEP_MEDIA_CONTROL Media Control Steps
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Table 5-4 lists the inactive Trace level options activities that can be monitored.

Viewing Trace Files

After you have selected the trace file options that you want to record, restart the 
Cisco CRA Engine (if you have modified inactive trace file options). After you 
observe enough engine activity to provide useful data, you can download and view 
the contents of the new trace file. 

To view trace files, click Trace files on the Engine Control page. To display the 
trace file, click on a filename.

Table 5-4 InactiveTrace Level options

Field or option Description

CCNUSER_STEPS Extension Mobility Steps

DB_STEPS Database Steps

DOCUMENT_STEPS Document Steps

ICM_STEPS Intelligent Call Management 
(ICM) Steps

IO_STEPS Input/Output Steps

IVR_STEPS IVR Steps

JAVA_STEPS Java Steps

LIB_DIRECTORY Directory Library

MESSAGING_STEPS Messaging Steps

STEP_AA AutoAttendant Steps

WEB_STEPS Web Steps

XML_STEPS XML Steps
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Using Cisco CRA Real-time Reporting
The Cisco IP Telephony system provides a real-time reporting utility, 
implemented as a Java applet communicating with the application server through 
remote method invocation (RMI). You can use this utility to generate reports on 
application activity.

This section covers the following topics:

• Installing the Real-time Reporting Tool, page 5-8

• Applying the Real-time Reporting Tool, page 5-9

Installing the Real-time Reporting Tool
To use Cisco CRA real-time reporting from a computer other than the application 
server, you need to install the application by performing the following steps:

Procedure

Step 1 Access the Application Administration main menu, by entering the following 
URL in the Location field of your browser:

http://<servername>/AppAdmin

where servername is the Domain Name Service (DNS) name or IP address of your 
application server.

The system displays a dialog box requiring your Cisco Customer 
Response Application (Cisco CRA) administrator username and password.

Step 2 Enter your Cisco CRA administrator name and password and click OK.

Step 3 Click Plug-in. 

The system displays the Plug-ins page.

Step 4 Click the Reporting Client link. 

The system displays the Save As... dialog box.
5-8
Cisco CallManager Extended Services Administrator’s Guide

78-12959-01



Chapter 5 Administering Cisco CallManager Extended Services
Using Cisco CRA Real-time Reporting
Step 5 Specify a target directory for the installer and click Save.

After the download completes, double-click CiscoCRA2_1Reporting.exe and 
follow the prompts.

You can connect to the reporting windows by entering the URL of the application 
server in your browser window.

Caution You must always use a valid host name or IP address. You cannot use the 
alias localhost, even when running the browser locally on the application 
server.

Applying the Real-time Reporting Tool
To start the real-time reporting utility, click Real-Time Reporting on the 
Application Administration main menu.

The system displays the Application Administration Reporting page. You can use 
this page to generate a variety of reports on the activity of your application engine.

The following options are available:

• Viewing Overall Application Engine Activity, page 5-9

• Monitoring Activity by Application, page 5-11

• Monitoring Activity by Task, page 5-12

• Resetting Statistics, page 5-12

• Printing Reports, page 5-13

Viewing Overall Application Engine Activity

To view overall application engine activity, select the System Totals option from 
the Reporting page.

This window shows the total activity for the application engine for a 24-hour 
period, updated at a regular interval (the default is three seconds).
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Table 5-5 summarizes the meaning of each field on this page.

Table 5-5 System Totals

Field Description

Total Sessions Total number of sessions run since the timestamp (“Data 
Collected Since”)

Max Concurrent 
Sessions

Maximum number of tasks that can run at the same time.

Data Collected 
Since

Time when data collection started. The system resets 
automatically at midnight.You can manually reset the 
statistics by choosing Reset Stats from the Tools Menu. 
Restarting the application server will also reset the 
statistics.

Running Sessions Number of tasks currently running.

Completed 
Sessions

Number of tasks completed without problems 
(exceptions).

Aborted Sessions Number of tasks that an unhandled exception terminated.

Running Rate The percentage of total tasks that are currently running.

Completion Rate Percentage of total tasks that completed without errors.

Aborted Rate Percentage of total tasks that terminated due to an 
unhandled exceptions.

Handled Rate Percentage of total tasks for an application that have been 
handled. The system designates a task as handled if the 
application has reached the Session Handled step.

Abandoned Rate Percentage of total sessions that were not handled for an 
application. If the Cisco IP Telephony application does not 
include a Session Handled step, the system counts all tasks 
associated with that application as abandoned. This also 
happens when someone who has called in to an application 
hangs up before the Session Handled step executes.
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Monitoring Activity by Application

To monitor activity by application, select the Application Activity option from 
the Reporting page.

The system displays the Application Activity page.

Table 5-6 summarizes the meaning of each field on this page.

Table 5-6 Application Activity

Field Description

Application Name of application. The application name is the name 
specified in the Application Configuration page.

Total Sessions Total sessions for a specific application.

Completed Sessions Number of sessions completed for an application without 
problems (exceptions).

Running Sessions Number of sessions currently running.

Aborted Sessions Number of sessions that were terminated for an 
application by an unhandled exception.

Handled Rate Percentage of total sessions that have been handled. The 
system designates a task as handled if the application 
reaches the Session Handled application step. 

Abandoned Rate Percentage of total sessions that were not handled. If the 
application does not include a Session Handled step, the 
system counts all tasks associated with that application 
as abandoned.
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Monitoring Activity by Task

To monitor activity by task, select the Task Activity option on the Reporting 
page.

Table 5-7 summarizes the meaning of each field on this page.

Resetting Statistics

The system automatically resets the accumulated statistics every day at 12:00 AM 
(by the application server system clock). You can also manually reset the statistics 
by choosing: Tools > Reset Stats on the Reporting page.

Table 5-7 Task Activity

Field Description

Task ID The identifier associated with the task started for the 
application or VRU script.

Parent ID Task ID of task that invokes this VRU script (this field is 
left blank for an application)

Media ID Cisco CallManager identifier or the call associated with 
this application.

Application Name of application or VRU script associated with this 
task. The application name is the name of the application 
definition (.aef) file.

Start Time Time the sessions for the application began execution.

Duration Application execution time in seconds.

Source ID Caller extension of incoming call. (CLID)

Destination ID Called extension to reach application associated with this 
task (configured route point directory number).
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Printing Reports

To create a printable version of a report, perform the following steps:

Procedure

Step 1 Choose the Report you want to print from the Reports menu on the Reporting 
page.

Step 2 Choose Tools > Open Printable

The system opens a printable version of the report in a new browser window.

Step 3 Choose Print from the File menu to print the report.

Using Cisco CRA Historical Reporting
In addition to viewing Real Time reports, you can view accumulated Cisco 
Customer Response Application (Cisco CRA) activity in historical reports. The 
historical reports record the same parameters that are used in the real time 
reporting feature.

When you enable historical reporting, the system automatically saves reports as 
.csv files to the Cisco CRA server hard disk. You can open the .csv files with a 
spreadsheet program like Microsoft Excel.

This section covers the following topics:

• Viewing IP IVR Historical Reports, page 5-14

• Enabling Historical Reporting, page 5-15

• Changing Historical Reporting Parameters, page 5-16
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Viewing IP IVR Historical Reports
The system saves a report of IP IVR activity to the Cisco CRA server hard disk 
every 24 hours. The file is named with the date of the recorded activity using the 
following convention:

servername.year.month.day.csv

where servername is the Domain Name Service (DNS) name of your application 
server.

To view a historical report, perform the following steps.

Procedure

Step 1 Access the Application Administration main menu, by entering the following 
URL in the Location field of your browser:

http://<servername>/AppAdmin

where servername is the Domain Name Service (DNS) name or IP address of your 
application server.

Alternatively, if you are on the application server computer, you can choose

Start > Programs > Cisco CRA Administrator > Application 
Administrator.

Step 2 On the Application Administration Main Menu page, click the 
Historical Reporting link.

Step 3 On the Historical Reporting page, click the name of the report you want to 
download.

Step 4 Follow the prompts to save the report to your local hard disk or open the copy of 
the file that is on the server.
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Enabling Historical Reporting
To enable historical reporting, perform the following steps:

Procedure

Step 1 Access the Application Administration main menu, by entering the following 
URL in the Location field of your browser:

http://<servername>/AppAdmin

where servername is the Domain Name Service (DNS) name or IP address of your 
application server.

Alternatively, if you are on the application server computer, you can choose

Start > Programs > Cisco CRA Administrator > Application 
Administrator.

Step 2 Click the Engine link.

Step 3 Click the Configure link on the left side of the web page.

Step 4 Make sure the Historical Reporting Status check-box is checked
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Changing Historical Reporting Parameters
The Cisco CRA Engine generates historical reports on a daily basis.The system 
stores these reports on your Cisco CRA server hard disk. To preserve hard disk 
space, you can limit the number of historical reports that your Cisco CRA system 
stores. 

The default setting is 90 days. This means that the system deletes historical 
reporting files that are more than 90 days old.

To change this value, perform the following steps:

Procedure

Step 1 Access the Application Administration main menu, by entering the following 
URL in the Location field of your browser:

http://<servername>/AppAdmin

where servername is the Domain Name Service (DNS) name or IP address of your 
application server.

Alternatively, if you are on the application server computer, you can choose

Start > Programs > Cisco CRA Administrator > Application 
Administrator

Step 2 Click the Engine link.

Step 3 Click the Configure link on the left side of the web page.

Step 4 In the Number of days to Preserve Historical Report Files field, enter your 
preferred value.
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Troubleshooting Cisco CallManager 
Extended Services

This section provides information on troubleshooting error messages for 
Cisco CallManager Extended Services. The following topics are included:

• Clearing Problems with Cisco CallManager Extension Mobility, page 6-1

• Clearing Problems with Cisco CallManager AutoAttendant, page 6-5

Clearing Problems with Cisco CallManager 
Extension Mobility

This section provides information for:

• Clearing General Problems, page 6-2

• Clearing Errors in Cisco CallManager Extension Mobility, page 6-2
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Clearing General Problems
Start with these general troubleshooting tips if any problems occur with Cisco 
CRA applications: 

• Check that you have thoroughly and correctly performed:

– all the installation steps in the “Installing 
Cisco CallManager Extended Services” section on page 2-3

– all the configuration procedures in the “Configuring Cisco CallManager 
Extension Mobility” section on page 3-1

• Try http://hostname:8080. Make sure that the embedded web server is 
running.

• Check that the port number is 8080. Remember that the default port number 
is 8080.

• Make sure that the URL is correct. Remember that the URL is case-sensitive.

Clearing Errors in Cisco CallManager Extension Mobility
Use the information in this section to clear problems which have error messages 
associated with them.

Unknown Error from Service

Action   Verify that all the Cisco CallManager services are running. 

Application Authentication Error

Action   Perform the following tasks:

1. Check the UserID and Password of the Extension Mobility user you created 
in Creating a New Application User, page 3-7.

2. Verify that you added the UserID and Password correctly in the “Adding the 
Login Application” section on page 3-10 and the “Adding the 
Logout Application” section on page 3-13.
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Device Does Not Allow Logon

Action   In the phone configuration page, make sure that “Enable Extension 
Mobility Feature” is selected. See the “Subscribing to the 
Cisco CallManager Login Service” section on page 3-32.

Device Profile Does Not Exist

Action   Ensure that there is a Default Device Profile associated with the user. See 
“Creating the Default Device Profile for a User” section on page 3-26.

Directory Service Error

Action   The LDAP Directory has a problem. There may a problem with the 
DirUser.jar file on the server machine.

Proxy Not Allowed

Action   Make sure that the Cisco CallManager Extension Mobility user has 
“Authentication Proxy Rights” enabled. See the “Creating a New Application 
User” section on page 3-7.

Another User Logged In

Action   Logout the user by selecting the Logout Service. Log back in to allow login 
access to the second user.

No User Logged In

Action   A user is trying to select logout service when no user is logged into the 
phone. A user cannot log out a device which does not have anyone logged in.

Null Name for Device

Action   Check that the firmware version of the phone is P00303010013 or later.
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Login Server Connection Error

Action   If you are running Cisco CallManager Extension Mobility on an IBM-340 
platform, check that the system allows anonymous access to the Login Service 
web site. See the “Setting up Anonymous Access on IBM-340 platforms” section 
on page 3-34.

Action   The URL of the Login Service may not be configured properly in the 
LDAP directory. Check that the URL is correct. See the “Adding the 
Login Application” section on page 3-10.

System Not Enabled

Action   The service parameter to enable Cisco CallManager Extension Mobility is 
set to off. Make sure that, on the Service Parameters Configuration page, the 
Login Service Enabled field is set to True (to enable the user login service). See 
the “Setting the Service Parameters” section on page 3-23.

User Logged in Elsewhere

Action   The service parameter which controls multiple logins is set to allow login 
at a single device and a user tries to log in at a second device. If the configuration 
is correct, explain the login policy to the user. If the configuration is incorrect, set 
the Multi Login Behavior field to multiple logins allowed. Refer to Setting the 
Service Parameters, page 3-23.

HTTP Error

Action   You may not have configured the proxy settings properly for Internet 
Explorer on the Cisco Customer Response Application (Cisco CRA) Engine. 
Contact your network administrator for information on configuring the proxy 
settings.
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Clearing Problems with Cisco CallManager AutoAttendant
This section describes how to clear the following problems that may impact 
Cisco CallManager AutoAttendant:

• No Matches for an Existing User, page 6-5

• Cisco CallManager AutoAttendant Prompt is Not Found, page 6-5

No Matches for an Existing User

Symptom A search fails for an existing user in the Cisco CallManager AA.

Possible Cause The user is not found because the ccndir.ini file is missing 
information or the extension is not valid because the user does not have a primary 
extension assigned in Cisco CallManager Administration.

Action   

1. Verify that the user has an entry in the Cisco CallManager AA Name dialing 
field and that the User record has an associated phone and that the primary 
extension button is selected.

2. Verify that the ccndir.ini file contains the following lines:
USERBASE “ou=Users, o=cisco.com”

PROFILEBASE “ou=profiles, ou=CCN, o=cisco.com”

3. If you migrated the Cisco CallManager from version 2.4, a possible schema 
issue exists. In the LDAP Directory Administration, verify that the user’s 
Owner field is in Userid format, not full name format.

Cisco CallManager AutoAttendant Prompt is Not Found

Symptom The Cisco CallManager AA prompt is not found.

Possible Cause Media configuration was not initialized properly.

Select Media from the main Application Administration page and verify that the 
prompt directory is listed as:
C:\program files\cisco\wffavvid\Prompts

and that the User Datagram Protocol (UDP) start port is 16384.
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